SAFETY PRECAUTIONS
(Read these precautions before using this product.)

Before using this product, please read this manual and the relevant manuals carefully and pay full attention to safety to handle the product correctly.

In this manual, the safety precautions are classified into two levels: "WARNING" and "CAUTION".

| WARNING | Indicates that incorrect handling may cause hazardous conditions, resulting in death or severe injury. |
| CAUTION | Indicates that incorrect handling may cause hazardous conditions, resulting in minor or moderate injury or property damage. |

Under some circumstances, failure to observe the precautions given under "CAUTION" may lead to serious consequences.

Make sure that the end users read this manual and then keep the manual in a safe place for future reference.

[Design Instructions]

WARNING

- When data change, program change, or status control is performed from a personal computer to a running programmable controller, create an interlock circuit outside the programmable controller to ensure that the whole system always operates safely. Furthermore, for the online operations performed from a personal computer to a programmable controller CPU, the corrective actions against a communication error due to such as a cable connection fault should be predetermined as a system.

CAUTION

- The online operations performed from a personal computer to a running programmable controller CPU (forced output and operating status changes) must be executed after the manual has been carefully read and the safety has been ensured. The operation failure may cause the injury or machine damage.
CONDITIONS OF USE FOR THE PRODUCT

(1) Mitsubishi programmable controller ("the PRODUCT") shall be used in conditions;
   i) where any problem, fault or failure occurring in the PRODUCT, if any, shall not lead to any major or serious accident; and
   ii) where the backup and fail-safe function are systematically or automatically provided outside of the PRODUCT for the case of any problem, fault or failure occurring in the PRODUCT.

(2) The PRODUCT has been designed and manufactured for the purpose of being used in general industries.

MITSUBISHI SHALL HAVE NO RESPONSIBILITY OR LIABILITY (INCLUDING, BUT NOT LIMITED TO ANY AND ALL RESPONSIBILITY OR LIABILITY BASED ON CONTRACT, WARRANTY, TORT, PRODUCT LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR LOSS OR DAMAGE TO PROPERTY CAUSED BY the PRODUCT THAT ARE OPERATED OR USED IN APPLICATION NOT INTENDED OR EXCLUDED BY INSTRUCTIONS, PRECAUTIONS, OR WARNING CONTAINED IN MITSUBISHI'S USER, INSTRUCTION AND/OR SAFETY MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the PRODUCT.

(“Prohibited Application”)

Prohibited Applications include, but not limited to, the use of the PRODUCT in:

• Nuclear Power Plants and any other power plants operated by Power companies, and/or any other cases in which the public could be affected if any problem or fault occurs in the PRODUCT.
• Railway companies or Public service purposes, and/or any other cases in which establishment of a special quality assurance system is required by the Purchaser or End User.
• Aircraft or Aerospace, Medical applications, Train equipment, transport equipment such as Elevator and Escalator, Incineration and Fuel devices, Vehicles, Manned transportation, Equipment for Recreation and Amusement, and Safety devices, handling of Nuclear or Hazardous Materials or Chemicals, Mining and Drilling, and/or other applications where there is a significant risk of injury to the public or property.

Notwithstanding the above, restrictions Mitsubishi may in its sole discretion, authorize use of the PRODUCT in one or more of the Prohibited Applications, provided that the usage of the PRODUCT is limited only for the specific applications agreed to by Mitsubishi and provided further that no special quality assurance or fail-safe, redundant or other safety features which exceed the general specifications of the PRODUCTs are required. For details, please contact the Mitsubishi representative in your region.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFETY PRECAUTIONS</td>
<td>A-1</td>
</tr>
<tr>
<td>CONDITIONS OF USE FOR THE PRODUCT</td>
<td>A-2</td>
</tr>
<tr>
<td>TABLE OF CONTENTS</td>
<td>A-3</td>
</tr>
<tr>
<td>1 MC APPBUILDER OVERVIEW</td>
<td>1-1</td>
</tr>
<tr>
<td>1.1 INTRODUCTION</td>
<td>1-1</td>
</tr>
<tr>
<td>2 SYSTEM REQUIREMENTS</td>
<td>2-1</td>
</tr>
<tr>
<td>3 INSTALLING MC WORKS64 / MC APPBUILDER</td>
<td>3-1</td>
</tr>
<tr>
<td>4 WORKBENCH SL</td>
<td>4-1</td>
</tr>
<tr>
<td>4.1 INTRODUCTION</td>
<td>4-1</td>
</tr>
<tr>
<td>4.2 PROJECT EXPLORER</td>
<td>4-2</td>
</tr>
<tr>
<td>4.3 THE RIBBON</td>
<td>4-5</td>
</tr>
<tr>
<td>5 MC APPBUILDER QUICK START</td>
<td>5-1</td>
</tr>
<tr>
<td>5.1 INTRODUCTION</td>
<td>5-1</td>
</tr>
<tr>
<td>5.1.1 Before You Begin</td>
<td>5-1</td>
</tr>
<tr>
<td>5.1.2 Creating a Project</td>
<td>5-2</td>
</tr>
<tr>
<td>5.1.3 Deploying a Project</td>
<td>5-19</td>
</tr>
<tr>
<td>5.1.4 Updating a Project</td>
<td>5-20</td>
</tr>
<tr>
<td>5.1.5 Configure Programmable Controller and OPC Server</td>
<td>5-22</td>
</tr>
<tr>
<td>6 HELP AND TECHNICAL SUPPORT</td>
<td>6-1</td>
</tr>
<tr>
<td>6.1 ONLINE HELP</td>
<td>6-1</td>
</tr>
</tbody>
</table>

REVISIONS
1 **MC AppBuilder Overview**

1.1 Introduction

Welcome to MC AppBuilder, a set of tools for System Integrators (SIs) to more easily create, deploy, and maintain projects using a combination of the Mitsubishi GX Works2 or GX Works3 and MX OPC Server products as well as the Mitsubishi MC Works64 product suite. This application is available as part of Workbench-SL.

You begin the project configuration process by creating or selecting a group of **templates** that define common settings, properties, symbols, and faceplates for the equipment within your automation system. You can import a **PLC program file** from GX Works2 or GX Works3 to establish a base set of properties and parameters for a template, and you can also add user-defined properties to the template known as **template properties**. These template properties allow you to connect to SCADA servers, such as TrendWorX64 and AlarmWorX64 from MITSUBISHI ELECTRIC CORP., to track anomalies and patterns in data relating to your equipment.
You then develop an *equipment hierarchy* in MC AppBuilder:

- You create *plant areas*, which are logical groups of cells. Each *cell* represents a PLC that you use within your automation system to control different equipment.

- Within each cell, you create *units*, which are logical groups of the *equipment* within the system. You can use units to organize your equipment by location, by equipment types, or by role.

As you add equipment to the equipment hierarchy, you apply the templates you have created to the new equipment. You can override the PLC properties and template properties for equipment that you add, allowing you to adjust for variations in your equipment's structure and capabilities.

After you have finished configuring equipment, you can add *NodePairs* to your project configuration. These NodePairs contain SCADA servers to which your equipment properties connect so that the servers can collect and report information. If some of your equipment properties need to communicate information using OPC servers other than the provided MX OPC server, you can also add additional OPC servers by configuring the *global settings* for your project.

Once you have finished changing the settings within your project configuration, you generate *SCADA displays* for your automation system. As MC AppBuilder generates these displays, it automatically associates information in the equipment properties and SCADA servers with the graphical displays you have configured in a SCADA display software product, such as GraphWorX64 from MITSUBISHI ELECTRIC CORP.. This automated configuration process saves you a great deal of configuration time and cost as you develop SCADA displays that track the status of your automation system.
2 **SYSTEM REQUIREMENTS**

For system requirements, refer to MC Works64 Getting Started Guide.
3 **INSTALLING MC WORKS64 / MC APPBUILDER**

For installing MC Works64/MC AppBuilder, refer to MC Works64 Getting Started Guide.
4 Workbench SL

4.1 Introduction

Workbench SL is intended to provide functionality that is similar to the WinForms/WPF-based Workbench -- now known as the Classic Workbench (also referred to within this Help as "Workbench64" or just "Workbench") -- of prior MC Works64 versions, but with improved "reach" and the ease-of-deployment that Silverlight technology offers. Workbench SL offers light-weight deployment with fast startup time, which also supports third-party plug-ins. It is capable of using existing data services (created using the Software Factory toolkit) as well as new WCF RIA Services. Workbench SL has a look-and-feel that is similar to Classic Workbench64, including familiar elements such as a toolbar ribbon and Project Explorer, but with enhanced user-friendly options such as a list-view Project Explorer for browsing, which can be filtered and sorted.

The Silverlight edition of Workbench64 runs in all browser platforms, including Microsoft Internet Explorer, Firefox, Safari, and so on.
Its Silverlight components are available as Web Parts in SharePoint and can run on Windows 7 Phone.
In Workbench SL, You Can:

- Organize data sources on the basis of a hierarchical structure of assets and equipment, using AssetWorX.
- Calculate, report on, and manage energy use if the AX Energy provider is installed.
- Locate and react to faults if the FDDWorX provider is installed.

4.2 Project Explorer

In MC Works64’s Workbench SL, there are two Project Explorers: the **Tree Explorer**, which contains a tree structure for navigating the provider (or applications); and the **Grid Explorer**, which contains the content of the item that is selected in the Tree Explorer and serves as a way to search the selected item. These two explorers and their features are highlighted in the following example. Note that the **Home** ribbon has options for showing or hiding these two explorers.

The Tree Explorer is primarily the navigational component for quickly accessing data in the installed applications. Button bars and icons make it easy to access applications from inside the Workbench. The Tree Explorer displays applications, tools, and server configuration and display files in a navigation tree style.
Its components can also be moved. In moving them you can:

- **Dock them** to any side of the Workbench64 window. To move the pane, click the title bar and move the pane onto any of the arrow icons of the Diamond Dock feature.
- **Leave them free floating.** Click and drag the tool bar of the Project Explorer off of a docked position to make it free floating. Double click on the Project Explorer title bar to return the pane to its last docked position.

- **Searchable Grid Project Explorer.** You cannot search the Tree Explorer, but you can search the Grid Explorer. Selecting a node in the Tree Explorer displays the node’s content in Grid Explorer. Note that you can search the selected item or you can search the entire database. You can also click on a column's filter icon to limit the content that appears in the pane.
4.3 The Ribbon

The ribbon for Workbench SL is designed to help you quickly find the commands you need to complete a task. Commands are organized in logical groups. The ribbon has two tabs: the **Home** tab provides general tool bar functions and changes depending on the item that is selected in the Project Manager, and the **Applications** tab gives you access to the providers (applications) that are in the Tree Explorer's button bar. Examples of both are shown below. You can minimize the ribbon by double-clicking on the ribbon tabs.

**Sample Home Tab in the Workbench SL Ribbon: This Ribbon Changes with Your Project Explorer Selections**

![Sample Home Tab in the Workbench SL Ribbon](image)

**Sample Applications Tab in the Workbench SL Ribbon**

![Sample Applications Tab in the Workbench SL Ribbon](image)

**Sample Tools and Settings Tab in the Workbench SL Ribbon**

![Sample Tools and Settings Tab in the Workbench SL Ribbon](image)
5  **MC AppBuilder Quick Start**

5.1 **Introduction**

You configure MC AppBuilder using Workbench-SL, a centralized tool for customizing HMI/SCADA displays using the Microsoft Silverlight platform. This topic walks you through the process of creating, deploying and updating a sample project in MC AppBuilder. You can complete a similar process to create and deploy projects for use in your own organization.

Note that the process described below is designed to allow you to create, deploy, and update a project as quickly as possible, not to present an exhaustive list of the options available in each of the dialogs mentioned below. For more information about these dialogs, consult the respective topics that offer more in-depth explanations of the options within these dialogs.

5.1.1 **Before You Begin**

Make sure that you have completed the following steps prior to creating and deploying your project in MC AppBuilder:

1. After carefully planning the structure of the equipment list and I/O assignment list(s) that you will use, either:

   a. Enter these lists into a spreadsheet program such as Microsoft Excel and save each list in the CSV file format, or

   b. Record the structure of these lists to use as a reference when creating equipment and assigning I/O addresses directly within MC AppBuilder.

2. After forming a plan for using templates within your project, either:

   a. Determine how you can apply the sample templates within MC AppBuilder to your equipment,
b. Have another member of your team configure templates for your equipment list within MC AppBuilder for you, or

c. Record your plan for creating templates to use as a reference when creating these templates directly within MC AppBuilder.

5.1.2 Creating a Project

To create a sample project in MC AppBuilder:

1. Open Workbench-SL by navigating to Start > All Programs > MELSOFT > MC Works64 > Tools > Workbench-SL. Make sure that the MC AppBuilder control is selected in the navigation tree, as shown below.
2. For this example, we will create a project in the default database ("MC AppBuilder").

How to create new configuration Database

a. Select [localhost] at Tree Explorer

b. Select “New Database” on ribbon menu.
c. The following dialog will be displayed, and enter database name of your choice (so as not to overlap), and check “Include sample data” and click the OK button.
※ It may take time to create database.

![Create a new Database dialog](image)

d. When database creation is complete, then appear [Database] (your database name) node under [localhost] at Tree Explorer.
3. We will use the predefined templates within MC AppBuilder to create this sample project. These templates appear under the **Mitsubishi** and **Mitsubishi_GX Works3** folder within the **Templates** tree node, as shown in the figure below.

4. For the purposes of this example, we will be using the default **Server Type** in MC AppBuilder (**MX OPC**).
5. To allow the cells in your equipment hierarchy to connect to alarm, trend, OPC, and AssetWorX servers, right-click the **Node Setup** tree node in the navigation tree and select the **Add NodePair** option. The **NodePair** dialog appears in the content area.
6. Enter a **name** for the node pair that represents a server or a redundant pair of servers, and use the provided list to select the **primary node** that contains the servers you wish to use to communicate with the equipment properties within a particular cell (or each cell if only one NodePair is configured). Optionally, you can also select a **secondary node** so that the cell can direct information to two servers simultaneously. In this example, we will create a NodePair called **local** that uses **localhost** as its primary node. Click the **Apply** button to add this NodePair to the project.
7. Right-click the NodePair you created in step 6 and select the **Add OPC Server** option. The **OPC Server** dialog appears in the content area. In this example, we will use the default options (the **Generate** check box is enabled, the **Use Secondary Node** check box is disabled, and the **server type** is set to **MX OPC**). Click the **Apply** button to add the server to the selected NodePair.
8. Right-click the NodePair you created in step 6 again and select the Add AssetWorX Server option. The AssetWorX Server dialog appears in the content area. In this example, we will use one of the AssetWorX databases that comes installed with MC AppBuilder. Click the Change Connection... button. The Select Database pop-up dialog appears.
9. Under **SQL connection Settings**, use the list to select the **database name** called **AssetWorX**. Click the **OK** button to close the pop-up dialog, then click the **Apply** button to add the server to the selected NodePair.
10. Right-click the NodePair you created in step 6 again and select the **Add AlarmWorX64 Server** option. The **AlarmWorX64 Server** dialog appears in the content area. In this example, we will use one of the AlarmWorX64 databases that comes installed with MC AppBuilder. Click the **Change Connection...** button. The **Select Database** pop-up dialog appears.
11. Under **SQL connection Settings**, use the list to select the **database name** called **AwxServer**. Click the **OK** button to close the pop-up dialog, then click the **Apply** button to add the server to the selected NodePair.

12. With the project configuration still expanded in the navigation tree, right-click on the **Equipment** tree node and select the **Import Equipment List** option. The **Import CSV File** pop-up dialog appears.
13. Click the **Browse** button to navigate to a CSV file that contains an equipment list ("Equipment.csv" in our example), then click the **Next** button. The **Import Equipment List** pop-up dialog appears.

14. An example of the table that appears in the **Import Equipment List** pop-up dialog appears below:

![Table of Equipment to Import](image)

Check that the table in this dialog contains the correct information. If it does not, click the **Back** button and browse for the CSV file again. Otherwise, click the
Finish button. The equipment list appears under the Equipment tree node in the navigation tree and connects to the appropriate templates automatically.

15. With the project configuration still expanded in the navigation tree, right-click the Equipment tree node and select the Import I/O Assignment List option. The Import CSV File pop-up dialog appears.

16. Click the Browse button to navigate to a CSV file that contains an I/O assignment list ("io.csv" in our example), then click the Next button. The Import I/O List pop-up dialog appears.
17. At this point, you can fill in the addresses that you wish to associate with each I/O property in the provided table. An example of the table that appears in the Import I/O List pop-up dialog, along with a sequence of filled-in addresses, appears below:

**Table of I/O Assignments to Import, with Addresses Filled In**

![Example Table of I/O Assignments](image)

**Note**: If you fill in the table within the Import I/O List with addresses, make sure that each address is unique to ensure proper SCADA generation later.

Check that the table in this dialog contains the correct information. If it does not, click the **Back** button and navigate to the CSV file again. Otherwise, click the **Finish** button. The I/O list appears under the appropriate plant area within the **Equipment** tree node.
18. To connect the plant area to a particular AlarmWorX server pair, select the **Servers** tab and choose an **AlarmWorX Server Pair** from the list (such as **LocalPC**). Click the **Apply** button to save your changes. When you save your changes, MC AppBuilder automatically assigns the name "AlarmWorXServer64" to the configuration.
19. To connect a cell to a particular PLC, select the cell under the **Equipment** tree node in the navigation tree. For this example, we will establish a connection between a PLC and the **WaterTanks** cell, which appears in the **WaterSupplyPlant** plant area within the equipment hierarchy. Select the **PLC** tab, enable the **Generate PLC Project** check box, and select a **Series** and **Type** of PLC from the respective lists, such as **QCPU (Q Mode)** and **Q00J**.

20. To connect the cell to a particular OPC server, select the **Servers** tab and choose an **OPC server** from the list (such as **local\MX OPC**). Click the **Apply** button to establish communication between the OPC server and the PLC that the cell represents.
21. To create an overview display that shows notifications for one of the cell's units, select the unit under the Equipment tree node in the navigation tree. For this example we will create an overview display for the CentralWaterTank unit, which is part of the WaterTanks cell and appears in the WaterSupplyPlant plant area within the equipment hierarchy. Select the Displays tab, then click the Add Overview button. The Overview Display Configuration pop-up dialog appears.

22. In this pop-up dialog, enter a display name for the overview display (such as CentralWaterTank). Click the OK button to close the dialog.

23. To assign the overview display you just created as the main display for the unit, click the General tab and select the overview display from the list next to the Main Display option (such as CentralWaterTank).

You may need to click the Refresh button to the side of the list in order for the display to appear as a list option. Click the Apply button to add the display to the unit's configuration.
5.1.3 Deploying a Project

To Deploy a Sample Project Created using MC AppBuilder:

1. To generate SCADA displays for the entire equipment tree, right-click the Equipment tree node and select the Generate SCADA option. If you would like to generate SCADA displays for a section of the equipment hierarchy, right-click the element of the section that appears highest in the equipment tree hierarchy and select the Generate SCADA option. In either case, the SCADA Generation Options pop-up dialog appears.

2. By default, MC AppBuilder generates SCADA systems for each of the servers and services that the product supports and stops the generation process if a warning occurs during pre-validation.

For this example, we will disable the Generic OPC Servers, Alarm Servers, and Trend Servers check boxes in the Generate column.
When you are ready to begin the generation process, click the **Generate SCADA** button.

3. As MC AppBuilder generates the SCADA systems, a **Generating SCADA...** pop-up progress window appears on the screen. An example of the messages you see in this progress window appears below.

![Generating SCADA Progress Window](image)

You can stop the generation process at any time by clicking the **Abort** button. Once the generation process is complete, click the **OK** button.

### 5.1.4 Updating a Project

After creating and deploying a project using MC AppBuilder, you can edit the SCADA system to add additional graphical elements, such as symbols and faceplates, or edit existing elements.

Note that the following steps walk you through one possible editing process within GraphWorX.

**To Update a Sample Project Created and Deployed using MC AppBuilder:**

1. In GraphWorX, select the **Symbols** tab in the lower-right corner of the screen. The label for the left-hand panel changes from "Explorer" to "Symbols."
2. Beneath the ribbon and the "Symbols" label on the left-hand panel, select the drop-down list to view the different types of symbols you can select. Open the _General > Tanks folder and double-click 2D_Tanks. Several symbols resembling tanks appear in the left-hand panel.

3. Find the Barrel symbol. Click this symbol and, while holding the left mouse button down, drag the symbol onto the display.

4. Save the changes you have made to the display by clicking the Save button above the File menu button or by clicking the File menu button, then clicking Save.

5. In MC AppBuilder, navigate to the cell to which you originally added a display. Select the Displays tab and click on the Configure button to update the overview display. The Overview Display Configuration pop-up dialog appears.

6. In this pop-up dialog, click the Import Display File button. The Upload File(s) pop-up dialog appears.
7. Click the **Browse** button to navigate to the location of the overview display for the cell. In this example, the file appears in the following directory:

C:\ProgramData\MELSOFT\McAppBuilder\GeneratedDisplays\Equipments\WaterSupplyPlant\WaterTanks\Central\WaterTank

The file structure parallels the equipment hierarchy, so a display for a cell (in the second level of the equipment hierarchy) appears in a folder two levels below the *Equipments* folder.

8. Select the file and click **Open**, then click **Close** and **OK** to exit the two pop-up dialogs.

9. Generate the SCADA system using the steps listed in Section 4.1.3 "Deploying a Project" and open the display in GraphWorX again. The changes you made in steps 1-3 are preserved.

### 5.1.5 Configure Programmable Controller and OPC Server

You need to configure displays, programmable controllers and OPC servers after executing "Generate SCADA" in MC AppBuilder.

For important details about configuring programmable Controller and OPC Server, refer to the following:

- [MC AppBuilder - Configure Programmable Controller and OPC Server.pdf](#)

  This file is available on your MC Works64 installation DVD.
6 **HELP AND TECHNICAL SUPPORT**

6.1 Online Help

MITSUBISHI ELECTRIC CORP. software provides online help with descriptions and explanations of each application. Help is available throughout MC WORKS64. You can access help in the following ways:

- Click the Help icon in the Workbench. This opens the help file for that application. To search for a topic in the help file, click the Index tab or the Search tab. Type or select the term you want to find, and then click the topic you want to read.

- Press the F1 key to display context-sensitive help.

- Click the Help button in any dialog box to display context-sensitive help for that dialog box.

- Move the mouse pointer over an icon and pause for a moment to display pop-up ToolTips for quick help.
### REVISIONS

*The manual number is given on the bottom left of the back cover.

<table>
<thead>
<tr>
<th>Print date</th>
<th>*Manual number</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>March 2013</td>
<td>BCN(NA)-P5999-0050-A</td>
<td>First edition</td>
</tr>
<tr>
<td>April 2015</td>
<td>BCN(NA)-P5999-0050-B</td>
<td>Correction Chapter 2</td>
</tr>
<tr>
<td>May 2016</td>
<td>BCN(NA)-P5999-0050-C</td>
<td>Correction Section 1.1, Chapter 2, Chapter 3, Section 5.1.2, Section 5.1.3, Section 5.1.5</td>
</tr>
</tbody>
</table>

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.

© 2013 MITSUBISHI ELECTRIC CORPORATION
Microsoft, Excel, Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

The company names, system names and product names mentioned in this manual are either registered trademarks or trademarks of their respective companies.

In some cases, trademark symbols such as `™` or `®` are not specified in this manual.
Specifications subject to change without notice.